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Before You Begin 

What You Should Know to Proceed 
To use the Microsoft® Excel EIS Builder, you should have a strong working knowledge of: 

Microsoft Excel 4.0 You should be familiar with entering data and working with worksheets, 
windows, formulas, and formatting in Microsoft Excel. You should also be familiar with 
Microsoft Windows TM or Apple Macintosh conventions such as choosing commands from 
menus and selecting options in dialog boxes. For more information, see the Microsoft Excel 
User's Guide and your Windows or Apple Macintosh documentation. 

The EIS Builder helps you automate basic activities without using the Microsoft Excel macro 
language. However, you may want to use conditional statements to add flexibility to scripts 
you write, and you can also enhance your EIS with macros that you create and include in the 
EIS. For example, you must use the macro language if you want to include a custom tool bar 
and custom tools, or allow the user to save EIS documents under other names. For more 
information, see the Microsoft Excel Function Reference. 

Your Data and the Way You Want to Present it Before using the EIS Builder, you may find it 
helpful to diagram the path or paths the user may take through the data. Knowing what you 
want to accomplish before you begin building a sophisticated information display and 
management system can help you create the system more quickly and easily. 

About the Documentation 
This book contains the following information. 

Chapter 

Chapter 1 

Chapter 2 

Chapter 3 

Chapter 4 · 

Glossary 

Title 

About the Microsoft Excel 
EIS Builder 

Getting Started with the 
Microsoft Excel EIS 
Builder 

Creating an Enterprise 
Information System with 
the Microsoft Excel EIS 
Builder 

Microsoft Excel EIS 
Builder Reference 

Description 

Gives an overview of the EIS Builder, including an 
introduction to creating your own EIS applications. 

Contains a step-by-step tour to quickly familiarize 
you with the most common activities involved in 
creating an EIS with the EIS Builder. 

Provides instructions for the tasks you will perform 
when creating your own EIS. 

Contains brief descriptions of the commands, 
actions, and macro sheets that are part of the EIS 
Builder. 

Contains definitions of the terms used throughout 
this book. 

v 
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Getting Help 
The online Help provided with the Microsoft Excel EIS Builder has complete documentation on 
actions, commands, and dialog box options, as well as the procedures, reference information, 
and glossary that are included in this book. 

There are several ways to get Help while you work with the EIS Builder. The Help you 
initially see depends on how you ask for Help. You must have previously installed the EIS 
Builder to get EIS Builder Help. 

EIS Builder Help Contents 
You can get Help from the EIS Builder Help Contents window in the following areas: 

• Basic concepts 

• An overview of the steps to create an EIS 

• A list of step-by-step procedures 

• EIS Builder command reference 

• EIS Builder script action reference 

• Definitions for EIS Builder terms 

EIS Builder Help for any EIS Builder Command You Specify 
You can get Help on any command on the EIS menu. Help for EIS Builder commands includes 
complete information on any dialog box which appears when you choose a command. 

EIS Builder Help for EIS Builder Dialog Boxes or Messages 
You can get Help on any EIS Builder dialog box or message which appears on your screen. 
Help for EIS Builder dialog boxes provides complete information on options and command 
buttons, with cross-references to related procedures. 

Searching EIS Builder Help for a Specific Topic 
You can search EIS Builder Help for any topic using a specific term or phrase. When you use 
Help to search for a specific term or phrase, Help will also list any topics related to the term or 
phrase for which you are searching. 

Microsoft Excel Help is also available when you are using the EIS Builder. For more 
information on Microsoft Excel Help, see "Using Help" in Chapter 2 of Book 1 of the 
Microsoft Excel User's Guide. 

~ To see EIS Builder Help Contents in Microsoft Excel for Windows 

• From the Help menu, choose EIS Builder Help. 

~ To see EIS Builder Help Contents in Microsoft Excel for the Macintosh 

• From the EIS menu, choose Help. 

~ To get Help on an EIS command 

1. Press SHIFT +Fl in Microsoft Excel for Windows, or COMMAND+SHIFT +QUESTION MARK (?) 
in Microsoft Excel for the Macintosh. 

The mouse pointer changes to a question mark. 

2. Choose the EIS menu command on which you want help. 
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..,.. To get Help in a dialog box or message box 

• Choose the Help button in the dialog box or message box . 

..,.. To search EIS Builder Help for a specific topic 

1. In Microsoft Excel for Windows, choose the EIS Builder Help command from the Help 
menu. 

In Microsoft Excel for the Macintosh, choose the EIS Builder Help command from the 
EIS menu. 

2. Choose the Search button. 

The Search window is displayed. 

3. Type the first letter of the word or phrase you're looking for, or select a word or phrase 
from the list of keywords. 

When you type a letter, the selection in the list shifts to the first keyword that begins with 
that letter. If several keywords begin with the same letter, you can type additional letters to 
move the selection to the keyword you want. 

4. Choose the Show Topics button to display a list of topics. 

Use the mouse or arrow keys to select a topic from the list. 

5. Choose the Go To button to go to the selected topic. 

Using Run-Time Files 
In Microsoft Excel for Windows, the files EIS.XLA, XTACTION.XLA, and EISUSER.HLP 
are "run-time" files. In Microsoft Excel for the Macintosh, EIS.XLA, XTACTION.XLA, and 
EIS USER HELP are "run-time" files. These run-time files may be distributed in accordance 
with Section 5 of the Microsoft License Agreement, along with your EIS, to users who do not 
have licensed copies of the EIS Builder author files. Users must have a licensed copy of 
Microsoft Excel to use an EIS with these run-time files. 

Microsoft Support Services 
Microsoft offers a variety of support options to help you get the most from your Microsoft 
product. This section summarizes these options. 

If you have a question about the Microsoft Excel EIS Builder, first look in the printed product 
documentation, or consult Help. If you cannot find the answer, contact Microsoft Product 
Support. 

Outside the United States, contact Microsoft Product Support Services at the Microsoft 
subsidiary office that serves your area. For information about Microsoft subsidiary offices, 
see "Product Support Worldwide" later in this section. 

Product Support Within the United States 
You can obtain product support for setup and installation of the EIS Builder in the following 
ways: 

Use the Microsoft Forums on CompuServe Microsoft Product Support Services is available on 
several CompuServe forums. For an introductory CpmpuServe membership kit specifically 
for Microsoft users, dial (800) 848-8199 and ask for operator 230. If you are already a 
CompuServe member, type GO MICROSOFT at any ! prompt. 
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Call Microsoft Product Support Services You can reach Microsoft Product Support Services 
between 6:00A.M. and 6:00P.M. Pacific time, Monday through Friday. 

For setup and installation support for the Microsoft Excel EIS Builder at no charge, dial (206) 
635-7070. 

For additional information about any of Microsoft's fee-based support options, call Microsoft 
Sales at 1-800-227-4679 between 6:30A.M. and 5:30P.M. Monday through Friday, Pacific 
time, excluding holidays. 

When you call, you should be at your computer with the Microsoft Excel EIS Builder running 
and have the appropriate product documentation at hand. Be prepared to give the following 
information: 

• The version number of the Microsoft product you are using 

• The type of hardware you are using 

• The exact wording of any messages that appeared on your screen 

· • What happened and what you were doing when the problem occurred 

• How you tried to solve the problem 

Microsoft TDD/TT (Text Telephone) Support Microsoft Product Support Services is available 
for the deaf and hard of hearing. Using a special TDD!TT modem, dial (206) 635-4948. Call 
between 6:00A.M. and 6:00P.M. Pacific time, Monday through Friday. 

Microsoft 's support services are subject to Microsoft prices, terms, and conditions in place at 
the time the service is used. 

Product Support Worldwide 
Microsoft provides product support services throughout the world. To receive product 
support, contact the Microsoft subsidiary office that serves your country. Microsoft subsidiary 
offices and the countries they serve are listed in "Microsoft Support Services" in Book 1 of 
the Microsoft Excel User's Guide. 

Microsoft Product Support Services Worldwide 
If you are outside the United States and have a question about the Microsoft Excel EIS 
Builder, Microsoft offers a variety of no charge and fee-based support options. To solve your 
problem you could: 

1. Consult the index and other printed product documentation 

2. Check on-line Help from the menu 

3. Check the README files that come with your product disks 

4. Consult electronic options such as CompuServe forums or Bulletin Boards if available in 
your country. 

If you cannot find a solution, you can receive information on how to obtain product support 
by contacting the Microsoft subsidiary office that serves your country. 

Microsoft's support services are subject to Microsoft's prices, terms, and conditions in place 
in each country at the time the service is used. 



CHAPTER 1 

About the Microsoft Excel 
EIS Builder 

Microsoft Excel EIS Builder Basics 
The Microsoft Excel EIS Builder is a collection of add-in macros that helps you create 
enterprise information systems (EISs) for your organization. You use EISs to control the 
presentation, updating, and manipulation of data, and the EIS Builqer enables you to create a 
complete EIS without writing any macro code. 

A typical EIS created with the EIS Builder includes: 

• Data presented in views you specify. 

• Custom menu bars, menus, commands, and buttons you create. 

• Scripts you write which specify the actions performed by the menu bars, menus, 
commands, and buttons. 

The users of your EIS will be able to move between views of data, manipulate information 
from remote databases, and perform other specialized actions. 

Your EIS can provide users with control over: 

Presentation and Control The Microsoft Excel EIS Builder gives you tools to easily control 
the display and status of documents. You can also allow users of your EIS to move data and 
even entire views out of the EIS to use in other presentations and reports they create. 

Data Access Most EISs are dynamic; they contain data linked to real-time data sources, such 
as external databases and other documents that contain data that changes over time. By 
controlling data access, you can control when and how the user updates data. You can also 
allow various levels of data access for different groups of users. 

Data Analysis EISs contain documents that allow the user to conduct specialized, controlled 
analysis of data. For example, the user can manipulate crosstab tables and what-if scenarios, 
and alter chart views to show different views of the data. 

The EIS Builder offers you the ability to use pre-written macros to quickly create a Microsoft 
Excel-based EIS. The EIS Builder's tools help you to quickly and easily create a fully 
interactive presentation of "live" data - data that can be automatically updated from external 
databases or directly manipulated in a controlled fashion by the user. 
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The advantage of using Microsoft Excel for an EIS is that much of the functionality that you 
need to use in an EIS- such as data entry, calculation and analysis, charting, and external 
database access and analysis- is in one integrated application. The complete Microsoft 
Open EIS Pak provides information on how to integrate the work you do in Microsoft Excel 
with the full suite of Microsoft applications, such as Microsoft Word, Microsoft Project, and 
Microsoft PowerPoint ®, for both Microsoft Windows and Apple Macintosh platforms. In 
Microsoft Windows, you can also use Microsoft Visual Basic n.•. 

The Microsoft Excel EIS Builder is a tool to help you automate the presentation of Microsoft 
Excel documents. It is not designed to help you create the data you want to display in your 
EIS. 

Before you begin using the EIS Builder: 
• Create and format the documents you want to use in your EIS. 

• Define database queries or crosstab tables. 

• Create links to Microsoft Excel documents. 

• Define links to documents outside Microsoft Excel. 

Use the Microsoft Excel EIS Builder to: 
• Define views of documents to be displayed in your completed EIS. 

• Add buttons, custom menu bars, menus, and commands to views that allow the user to 
execute commands and actions. 

• Attach scripts to your buttons, custom menu bars, menus, and commands to automate the 
display of information in your EIS. 

• Control access and data exchange between Microsoft Excel documents and documents in 
other applications. 

• Control the user's access to recalculation and other data manipulation actions. 

Parts of a Microsoft Excel EIS 
A Microsoft Excel EIS consists of worksheets you use to display data and charts, and macro 
sheets you use to automate and control the worksheets. You use the tools made available by 
the EIS Builder to create an EIS from a set of worksheets. Then you include those 
worksheets, along with the macro sheet that automates your EIS, in your completed file set. 

Worksheets 
A Microsoft Excel EIS displays worksheets. Some of your worksheets, and the charts 
connected to them, can be linked to remote sources of data - documents used in other 
applications or documents contained in databases, either on a local computer, on a network, 
or on a mainframe. Worksheets you use in an EIS can also contain OLE objects from other 
applications, such as linked graphics, or files from Microsoft Project or any other application 
that supports object linking and embedding. 
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EIS Macro Sheets 
Macro sheets provided with the EIS Builder contain the macros that run the scripts in your 
completed EIS. The EIS Builder records the choices you make on a macro sheet named 
APP.XLA. This macro sheet records actions such as defining views and adding menus and 
buttons. The first time you save an EIS, the EIS Builder creates a copy of APP.XLA and gives 
it the name you specify. In future development sessions, you open this document to continue 
developing the EIS. When you distribute your EIS to users, you have to include this macro 
sheet along with the other Microsoft Excel documents that are part of the EIS. 

Creating an EIS 
This section describes how to create an EIS with the Microsoft Excel EIS Builder. Chapter 2 
offers a hands-on tour that allows you to use sample files provided with the EIS Builder to 
create a simple, two-screen application. 

Designing Your EIS 
Knowing what you want to accomplish before you begin building a sophisticated information 
display and management system can help you create the system more quickly and easily. 
Before using the Microsoft Excel EIS Builder, you should plan how the user will navigate 
through the data. You should also identify: 

• The data you want to display. 

• How you want to make it available to the user. 

• The level of interaction you want the user to have with the data. 

• The actions you want the EIS to perform for the user. 

Creating the Documents You Want to Use in Your EIS 
Before you begin using the Microsoft Excel EIS Builder, create the worksheets and charts 
that you want to use in your completed EIS. The worksheets you display in an EIS can 
contain anything you would normally use on a Microsoft Excel worksheet, such as: 

• Charts 

• Database crosstab tables 

• Database queries 

• Embedded objects 

Building Your EIS 
Start the Microsoft Excel EIS Builder and Create a New EIS When you open the Microsoft 
Excel EIS Builder, a menu containing commands you use to create your EIS is installed. As 
you create the EIS, the selections you make in EIS Builder dialog boxes are recorded in a 
macro file. For more information, see "Installing and Starting the EIS Builder" and "Creating 
or Opening an EIS" in Chapter 3. 
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Define the Views of Worksheets that will be Displayed in the EIS After opening the documents 
you want to display in your EIS, you use the Microsoft Excel EIS Builder to define views of 
those documents. Views are portions of existing Microsoft Excel documents that you want to 
display. For more information about views, see "Working with Views" in Chapter 3. 

·=-
·=­
·=-

Controlling Navigation Between Views of Data Once you have defined views, you create a way 
for the user to move between views of data, to quit your EIS, and to quit Microsoft Excel. Use 
custom menu commands and buttons to automate the display of views. When you create 
buttons and commands, you define scripts that run when you click a button or choose a 
command. Scripts are collections of actions, and each action runs a command-equivalent or 
action-equivalent macro. For more information about menus and commands, see "Working 
with Menus" in Chapter 3. For more information about scripts and actions, see "Working with 
Scripts" in Chapter 3 and "Reference to Actions" in Chapter 4. For more information about 
buttons, see "Working with Buttons and Graphics" in Chapter 3. 

Create custom controls to automate your EIS. 

Menu Bars 
Menus 
Commands 
Buttons 
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Controlling the User's Interaction with Data Your EIS can contain database crosstab tables or 
queries to databases. When you include a predefined database crosstab table, you can control 
the way a user changes the crosstab table's configuration, as well as the formatting and 
charting of the data. Using database queries in your EIS allows you to control when and how 
the user can initiate queries on the external database. For more information about crosstab 
tables and queries in your EIS, see "Working with Queries and Crosstab Tables" in Chapter 3. 

You can limit the user's ability to alter the display and contents of the EIS worksheets with 
bulletproofing. Items that you can control through bulletproofing options include the formula 
bar, scroll bars, keyboard entry, and worksheet navigation. You can also control what the user 
can enter into a cell. For example, you can specify that the user enter an interest rate between 
5% and 15% into a particular cell. For more information about bulletproofing, see "Changing 
Bulletproof Settings" in Chapter 3. For more information about restricting cell entries, see 
"Working with Buttons and Graphics" in Chapter 3. 

Testing Your Completed EIS 
Before installing your EISon users' machines, you should run it as a user will. This lets you 
see how the completed EIS works. Test your EIS using all the hardware configurations on 
which the completed system will run. You should also run it under conditions that are likely 
to cause errors when the user runs the system, such as when remote databases are not 
available when expected. 

Installing Your Completed EIS 
When you install your EIS on users' machines or on network servers, include all the 
worksheets and macro sheets required to use the EIS. You should also make sure the 
documents in your EIS don't have links to documents that you won't be including in your 
final version. 

Note If you are going to develop EIS applications that will be used on both Windows and 
Macintosh platforms, please refer to the information on cross-platform issues in the 
README. TXT file on your Macintosh EIS disks. 





CHA P TER 2 

Getting Started with the Microsoft 
Excel EIS Builder 

This tour leads you through the general sequence of steps you will take when you build an EIS. 
Before using this tour, see "Creating an EIS" in Chapter 1. 

The tour uses sample files installed with the EIS Builder. If you plan to use this tour more than 
once, make a copy of the tour files before using the tour. 

.,.. To create a new EIS 

1. Start Microsoft Excel. 

2. From the Options menu, choose Toolbars. 

3. Under Show Toolbars, select a toolbar you have currently displayed. 

4. Choose the Hide button. 

5. Repeat steps 2 through 4 until you have hidden all of the tool bars that are displayed. 

6. From the File menu, choose Open. 

7. Select AUTHOR.XLA. 

8. Choose the OK button. 

The EIS menu is added to the menu bar. 

9. From the EIS menu, choose New. 

10. Type your name and EIS Demo in the New Application Title box. 

11 . Choose the OK button. 

12. From the EIS menu, choose Save. 

13. In the File Name box, type DEMO.XLA 

14. Choose the OK button. 

7 

The EIS Builder creates a new macro sheet to record the choices you make with the EIS Builder. 
When you are finished creating your EIS, you will include this macro file with the worksheets 
and other documents that are part of your EIS . 

.,.. To add a splash file 

You may want to display a splash file when your EIS is started. A splash file is a Microsoft 
Excel document containing an image that you want to have displayed while the EIS files are 
loading. You can use this file to display the name of the EIS, the name of the company or people 
the EIS was created for, and other information about the EIS. 

1. From the EIS menu, choose Settings. 

The Application Settings dialog box appears. 
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2. Under Splash File, choose the Browse button. 

The Splash File dialog box appears. 

3. In the File Name box, select DSPLASH.XLS. 

In Microsoft Excel for the Macintosh, select DEMO SPLASH FILE. 

4. Choose the OK button. 

In Microsoft Excel for the Macintosh, choose the Open button. 

The Application Settings dialog box reappears. 

5. Choose the OK button. 

IJII- To display a menu with views 

You can specify a menu to be displayed whenever a specific view is displayed. 

1. From the EIS menu, choose Settings. 

The Application Settings dialog box appears. 

2. Choose the Defaults button. 

The New View Settings dialog box appears. 

3. Under Menu Bar, select the Application option button to specify that all the new views use 
the application menu, which you'll create later. 

4. Choose the OK button. 

The Application Settings dialog box reappears. 

5. Choose the OK button. 

IJII- To define a view 

An EIS provides a highly structured and controlled way of displaying and manipulating data. 
Most of your data will be on Microsoft Excel worksheets. The EIS Builder provides a way to 
specify ranges on worksheets as views that can be displayed in your completed EIS. You can 
easily display and hide views at any time. 

1. From the File menu, choose Open. 

2. Select DCHARTS.XLS. 

In Microsoft Excel for the Macintosh, select DCHARTS. 

3. Choose the OK button. 

In Microsoft Excel for the Macintosh, choose the Open button. 

4. Select the area on the sheet you want to use as the view. Include the quarterly data and the 
embedded chart. 

5. From the EIS menu, choose View. 

The View dialog box appears. 

6. Choose the Add button. 

The View Settings dialog box appears. 

7. In the View Name box, type Demo Screen One 

8. Choose the OK button. 

IJII- To add a button to toggle the chart on and off 

You may not always want the chart to be displayed on the view. To give users of your EIS the 
option of displaying the chart, you can add a button which will alternately display and hide the 
chart on the view. 

1. Select a cell above the chart. 
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2. From the EIS menu, choose Button. 

The Draw Button dialog box appears. 

3. In the Button Type box, select Stick-it Note. 

4. In the Text box, type Toggle Chart 

5. Select the Size To Cell check box. 

6. Choose the Draw button. 

The button is drawn on your view. The Script dialog box appears. 

7. Under Action Class, select the Display option button. 

8. In the Available Actions box, select Toggle Object. 

9. Choose the Add button. 

The Script Action dialog box appears. 

10. In the Description box, type Toggle Chart On/Off 

11. Select Chart 3 in the Name of Object box. 

Note The word "chart" is translated in international versions of Microsoft Excel. 

12. Choose the OK button. 

The Script dialog box reappears. 

13. Choose the Close button. 

The Toggle Chart button is added to the worksheet. A script that controls the display of Chart 
3 is attached to the button. When you click the button, the script is run and the chart will be 
displayed or hidden. When you run a script in author mode, the commands on the EIS menu 
are disabled and the Halt tool appears. Click the Halt tool to activate the EIS Menu 
commands after running a script. 

~ To create a cell that prompts for input 

You can make selected cells on worksheets in your EIS hot. When a hot cell is clicked, a dialog 
box appears which prompts the user for a specific type of input. You can also restrict entries in a 
hot cell to a specific type of data, such as text, number, date, or to a range of values, such as 
between 20 and 30. 

1. Select the cell that contains the Estimated Growth number. 

2. From the EIS menu, choose Prompt Cell. 

The Prompt Cell Name dialog box is displayed. 

3. Type Growth for the cell name. 

4. Choose the OK button. 

The Prompt Cell Settings dialog box is displayed. 

5. In the Prompt Message box, type Enter new growth forecast: 

6. Under Validation, select Number. 

7. In the Min Value box, type 0 

8. In the Max Value box, type 15% 

9. Select the Make Cell Hot check box. 

10. Choose the OK button. 
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IJl> To define a view of a crosstab table 

1. From the File menu, choose Open. 

2. Select DCROSTAB.XLS. 

In Microsoft Excel for the Macintosh, select DCROSTAB. 

3. Choose the OK button. 

In Microsoft Excel for the Macintosh, choose the Open button. 

4. Select the area on the sheet you want to use as the view. Include the cell at the upper-left 
comer of the worksheet and all of the cross tab table. 

5. From the EIS menu, choose View. 

The View dialog box appears. 

6. Choose the Add button. 

The View Settings dialog box appears. 

7. In the View Name box, type Demo Screen Two 

You'll use the View Settings dialog box in the next procedure, so it remains on the screen. 

IJl> To open the crosstab table source data sheet when entering the view 

When Demo Screen Two is displayed, you'll want to make sure that the worksheet containing 
the data to which the cross tab table is linked is also opened. You can create a script that opens 
the source data worksheet when the crosstab table worksheet is displayed. 

1. Choose the Scripts button. 

The Script dialog box appears. 

2. In the Run Script On box, make sure Enter is selected. 

The script you create will be run when the user views or enters, Demo Screen Two. 

3. Under Action Class, select the Display option button. 

4. In the Available Actions box, scroll down and select Echo Off. 

5. Choose the Add button. 

6. Under Action Class, select the Files/Windows option button. 

7. In the Available Actions box, select Open File. 

8. Choose the Add button. 

The Script Action dialog box appears. 

9. In the Description box, type Open crosstab data sheet 

10. In the Filename box, type DDATA.XLS 

In Microsoft Excel for the Macintosh, type CROSST AB DATA 

11. Select the Read Only check box. 

12. Choose the OK button. 

The Script dialog box reappears. 

You'll use the Script dialog box in the next procedure, so it remains on the screen. 

IJl> To close the crosstab table source data sheet when exiting the view 

You will want the sheet to be closed when the user leaves the cross tab table view. You can 
create a simple script to close the crosstab source data sheet. 

1. In the Run Script On box, select Exit. 

The script you create will be run when the user leaves Demo Screen Two. 

2. Under Action Class, select the Files/Windows option button. 
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3. In the Available Actions box, select Close File. 

4. Choose the Add button. 

The Script Action dialog box appears. 

5. In the Description box, type Close the crosstab data sheet 

6. In the Name of Sheet to Close box, type DDATA.XLS 

In Microsoft Excel for the Macintosh, type CROSS TAB DATA 

7. Choose the OK button. 

The Script dialog box reappears. 

8. Choose the Close button. 

The View Settings dialog box reappears. 

9. Choose the OK button . 

.,. To define the crosstab table settings 

You can control the way the user interacts with a data crosstab table in your EIS. The Crosstab 
command on the EIS menu displays a dialog box that allows you to choose the level and type of 
data manipulation the user can perform. You can also specify that any Microsoft Excel 
automatic formats be applied to the crosstab table and to any source sheet drilldowns the user 
performs. 

1. From the EIS menu, choose Crosstab. 

The Crosstab Setup dialog box appears. 

2. In the Crosstab Sheet box, select Colorful 2. 

3. Select the Source Record Drilldown check box. 

This option allows the user to double-click a cell in the worksheet to drill down to the 
crosstab table data. 

4. In the Drilldown Sheet box, select Colorful 2. 

5. Choose the OK button . 

.,. To add a button that allows users to change the crosstab table 

In addition to simply displaying data, users of your EIS can also manipulate it. In the following 
procedure, you'll add a button to a worksheet containing a data crosstab table that will allow the 
user to redefine the crosstab table. 

1. Select a cell above the table. 

2. From the EIS menu, choose Button. 

3. In the Button Type box, select Stick-it Note. 

4. In the Text box, type Change Crosstab 

5. Choose the Draw button. 

The button is drawn on your view. The Script dialog box appears. 

6. Under Action Class, choose the Data Access option button. 

7. In the Available Actions box, make sure Define a Crosstab is selected. 

8. Choose the Add button. 

9. Choose the Close button. 
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~ To add a button to go from one view to another view 

Once you've created several views, you'll want to create an easy way for the user to move 
between views. You can add buttons to views and attach to those buttons scripts which display 
another view when the button is clicked. 

1. Select a cell next to the Change Crosstab button. 

2. From the EIS menu, choose Button. 

The Draw Button dia!og box appears. 

3. In the Button Type box, select Stick-it Note. 

4. In the Text box, type Chart View 

5. Choose the Draw button. 

The Script dialog box appears. 

~ To attach a script to the button 

1. Undef Action Cla,.ss, make sure the Views option button is selected. 

2. In the Available Actions box, make sure Display View is selected. 

3. Choose the Add button. 

The Script Action dialog box appears. 

4. In the Description box, type Display Chart View 

5. In the View box, make sure Demo Screen One is selected. 

6. Choose the OK button. 

7. Choose the Close button. 

The button you specified is created on the view at the selected cell. The action script you created 
is attached to the button so that the next time you click the button, the Demo Screen One view 
will be displayed. 

~ To create a custom menu 

The Microsoft Excel EIS Builder helps you easily create custom menus and commands. These 
menus and commands can be displayed whenever the EIS is used, or just when specific views 
are displayed. You create scripts so each command performs an action. 

1. From the EIS menu, choose Menu. 

The Menus dialog box appears. 

2. Under Menu Type, select the Application option button. 

3. Under Menus, choose the New button. 

The New Menu dialog box appears. 

4. Type Demo Menu 

5. Choose the OK button. 

The Demo Menu is added to the Menus box, and the Commands section of the dialog box is 
activated, allowing you to create commands for the Demo Menu. 

~ To add commands to a menu 

1. Under Menus, make sure Demo Menu is selected. 

2. Under Commands, choose the New button. 

The Menu Command Definition dialog box appears. 

3. In the Command Text box, enter Display Crosstab 
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4. Choose the Script button. 

The Script dialog box appears. 

5. Under Action Class, make sure Views is selected. 

6. In the Available Actions box, make sure Display View is selected. 

7. Choose the Add button. 

The Script Action dialog box appears. 

8. In the Description box, type Display the crosstab view 

9. In the View box, select Demo Screen Two. 

10. Choose the OK button. 

The Script dialog box reappears. 

11 . Choose the Close button. 

The Menu Command Definition dialog box reappears. 

12. Choose the OK button. 

The Menus dialog box reappears. 

Repeat steps 2 through 12 to create a menu command that displays the chart view. When you 
are finished creating commands, choose the Close button in the Menus dialog box. 

To define the home view and the first view 

1. From the EIS Menu, choose Settings. 

The Application Settings dialog box appears. 

2. Choose the Details button. 

The Application Details dialog box appears. 

3. In the Home View box, select Demo Screen One. 

4. In the First View box, select Demo Screen One. 

5. Choose the OK button. 

The Application Settings dialog box reappears. 

6. Choose the OK button. 

To allow the user to quit the EIS 

Every EIS you create should include a way for the user to quit the EIS or Microsoft Excel. 

1. In Microsoft Excel for Windows, from the Window menu, choose DCHARTS.XLS. 

In Microsoft Excel for the Macintosh, choose DCHARTS. 

2. Select a cell next to the Toggle Chart button. 

3. From the EIS menu, choose Button. 

The Draw Button dialog box appears. 

4. In the Button Type box, select Stick-it Note. 

5. In the Text box, type Exit EIS 

6. Choose the Draw button. 

The button is drawn on your view. The Script dialog box appears. 

7. Under Action Class, select the Application option button. 

8. In the Available Actions box, select Quit EIS. 

If you prefer to have the user exit both the EIS and Microsoft Excel at the same time, select 
Quit Microsoft Excel instead of Quit EIS. 
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9. Choose the Add button. 

10. Choose the Close button. 

IJiil> To run the EIS 

After developing an EIS, you will want to test it by using it as a user would. 

1. From the EIS menu, choose Run. 

The Run Application dialog box appears. 

2. Choose the Beginning' button. 

The EIS menu is disabled and all of the scripts in your EIS are activated. To return to author 
mode, click the Halt tool. 

IJiil> To quit the EIS 

1. From the EIS menu, choose Exit. 

If you have made changes to any open documents and not saved them, Microsoft Excel asks 
you if you want to save the changes before closing. 

2. Choose the Yes button to save changes, the No button to discard changes, or the Cancel 
button to cancel the command. 
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The Microsoft Excel EIS Builder is designed to make creating an enterprise information system 
(EIS) in Microsoft Excel quick and efficient. This chapter details the procedures you'll use to 
create a powerful, Microsoft Excel-based EIS . 

Installing and Starting the EIS Builder 
The Microsoft Excel EIS Builder is a set of add-in macro sheets that you use to add controls to 
documents you want to use in an enterprise information system. When you open the 
AUTHOR.XLA file, the EIS menu is added to the Microsoft Excel menu bar. This menu 
contains commands that help you create an EIS. 

IIi> To install the EIS Builder for Microsoft Excel for Windows 

1. Start Microsoft Windows. 

2. Insert the disk labeled Setup in drive A. 

3. From the File menu in either the Program Manager or the File Manager, choose Run. 

4. Type a:setup 

5. Press ENTER. 

6. Follow the instructions on the screen. 

IIi> To install the EIS Builder for Microsoft Excel for the Macintosh 

1. Insert the disk labeled Setup in the disk drive. 

2. Double-click the Microsoft Excel EIS Builder Setup icon. 

3. Follow the instructions on the screen. 

IIi> To start the EIS Builder 

1. Start Microsoft Excel. 

2. From the File menu, choose Open. 

3. In Microsoft Excel for Windows, select AUTHOR.XLA in the EISBLDR directory. 

In Microsoft Excel for the Macintosh, select AUTHOR.XLA in the EIS BUILDER folder. 

The EIS menu is added to the right of the Window menu on the menu bar. Other add-in 
macro sheets that are part of the EIS Builder are opened from the EIS menu. For more 
information about the macro sheets that make up the Microsoft Excel EIS Builder, see 
"Reference to EIS Macro Sheets" in Chapter 4. 
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Creating or Opening an EIS 
Before you use the Microsoft Excel EIS Builder to create an EIS application, you should have 
already created all of the documents that will be used in the EIS. This includes documents that 
will be displayed in the finished EIS and documents that may not be displayed, such as external 
databases that provide supporting data. 

While you create a new EIS application, the commands you select from the EIS menu are 
recorded in one of the EIS Builder' s macro sheets, named APP.XLA. When you save a new EIS 
application for the first time, you are prompted to give a new name to the APP.XLA macro 
sheet. 

~ To create a new EIS 

1. From the EIS menu, choose New. 

2. In the New Application Title box, type the title you want to use for the application. 

3. Choose the OK button. 

~ To open and modify an existing EIS 

1. From the EIS menu, choose Open. 

2. In the File Name box, select the EIS macro sheet that you want to open. 

Only add-in macro sheet files created with the Microsoft Excel EIS Builder can be opened. 

You can work with only one EIS at a time. 

3. In Microsoft Excel for Windows, choose the OK button. 

In Microsoft Excel for the Macintosh, choose the Open button. 

The EIS macro sheet you previously created is opened. 

4. To open the documents associated with all views in the EIS, choose Run from the EIS menu, 
and choose the Beginning button. 

You can also choose the Open command from the File menu and select the documents with 
which you want to work. In Microsoft Excel for Windows you can select more than one 
document by dragging through a continuous group of documents, or by holding down 
CONTROL and clicking individual documents. 

5. In Microsoft Excel for Windows, choose the OK button. 

In Microsoft Excel for the Macintosh, choose the Open button. 

~ To specify EIS settings 

The Microsoft Excel EIS Builder allows you to specify a variety of global settings for an EIS. 
You can control variables such as passwords and initial views, and whether the system responds 
to double-clicks and documents that are open when the EIS is started. You can also specify a 
splash file that is displayed while your EIS is being opened. 

1. From the EIS menu, choose Settings. 

The Application Settings dialog box is displayed. 

2. Choose the Details button. 
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3. Enter the information and select the options you want in the Application Details dialog box. 

For a description of the options, choose the Help button. 

4. Choose the OK button to close the Application Details dialog box. 

5. To specify a splash file, type in the Splash file box the name of the document you would like 
to have displayed while the EIS is opened. 

You can also choose the Browse button and then select the file from the Splash File dialog 
box. 

In Microsoft Excel for Windows, after selecting the file, choose the OK button. 

In Microsoft Excel for the Macintosh, choose the Open button. 

6. Choose the OK button to close the Application Settings dialog box . 

..,. To specify default view settings 

You can specify default settings that will apply to each new view you create in an EIS. These 
defaults determine the menu bar or menu that is displayed and the scripts that are run when the 
view is entered, exited or changed. You can also specify settings for individual views as you 
create them. 

For more information about views, see "Working with Views" later in this chapter. 

1. From the EIS menu, choose Settings. 

The Application Settings dialog box is displayed. 

2. Choose the Defaults button. 

The New View Settings dialog box is displayed. 

3. Select the options you want. 

For a description of the options, choose the Help button in the dialog box. 

4. Choose the OK button . 

..,. To save an EIS 

• From the EIS menu, choose Save. 

Microsoft Excel saves the macro sheet containing information about the EIS and prompts 
you to save any other open documents. If you haven't saved the EIS before, you are also 
prompted to name the new EIS file. The default EIS file name is APP.XLA. 

..,. To switch from author mode to user mode 

While you are creating an EIS, you may want to see how it will work when run by a user. 
The Run command on the EIS menu disables all of the authoring commands on the EIS 
menu, allowing you to use the EIS just as a user would. 

1. From the EIS menu, choose Run. 

2. In the Run Application dialog box, select Beginning or Current View. 

The EIS Builder switches to user mode, but displays the Halt tool in the upper-left comer of 
the window, and the EIS menu is disabled. 

3. Click the Halt tool to return to author mode. This enables the EIS menu command. 
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..,. To close an EIS 

• From the EIS menu, choose Close. 

If you have made changes to the EIS, you will be prompted to save the changes. Choose the 
Yes button to save the EIS macro sheet. You will then be prompted to save each document 
that has changed. 

To save the EIS and all documents in one step, choose the Yes To All button . 

..,. To quit the EIS Builder 

• From the EIS menu, choose Exit. 

If you have made changes to any open documents, you are prompted to save the changes 
before closing. Choose the Yes To All button to save the EIS and all associated open 
documents . 

..,. To display a list of document links 

Before you install your completed EISon your users' machines, you may want to check the links 
on the documents you include in the EIS. It is important that none of the documents included in 
the EIS be linked to documents that are not either included in the EIS or that will not typically 
be available to the user when the EIS is run. 

1. From the EIS menu, choose Utilities. 

The Run Utility dialog box is displayed. 

2. Select Document Links. 

3. Choose the OK button. 

A new worksheet is created listing each view in the EIS, the full path and document that 
contains the view, and any links between the document and any other documents. 

Working with Views 
With the EIS Builder, you can create different views to present to the user, and use scripts to 
control the display of data and the user' s access to data. Views consist of a document and the 
display settings, size, and position of the window containing the document. You create views 
from worksheets. The first view you create is the home view. The home view can contain: 

• Controls that allow the user access to other views in the EIS. 

• The name of the organization for which the EIS is developed. 

• A name you assign to the EIS. 

• Information about using the EIS. 

• Access to online Help for the EIS. 
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The following is an example of a typical home screen. 
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Clicking on any of the charts displays the 
data the chart re resents. p 

~ To create a view 

1. Open the document you want to define as a view. 

2. Select the range on the document you want included in the view. 

3. From the EIS menu, choose View. 

4. Choose the Add button. 

5. In the View Name box, type the name you want to use for the view. 

6. To specify display attributes for the view, choose the Details button. 

To create a script to run when entering, exiting, opening, closing, or changing a view, choose 
the Scripts button. 

To control bulletproofing properties, choose the Settings button. 

If you have defined menus using the Menu command from the EIS menu, you can also 
specify menus to be displayed when the view is displayed. 
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7. Select the options you want. 

For a description of the options, choose the Help button in the dialog box. 

8. Choose the OK button. 

If the document has not yet been saved, the Save View As dialog box is displayed. Type a 
name for the document and choose the OK button. 

Jll> To change an existing view 

After creating a view, you can change the portion of a worksheet to which the view refers, the 
name of the view, or the settings, details, or script choices you defined for the view. 

1. From the EIS menu, choose View. 

2. From the Views box, select the view you want to change. 

3. Choose the Edit button. 

4. The view you selected and the View Settings dialog box are displayed, allowing you to 
change the settings for the view. 

5. Select the options you want to define or change for the view. 

For a description of the options, choose the Help button in the dialog box. 

6. Choose the OK button to save the changes to the view. 

Jll> To display a view 

1. From the EIS menu, choose View. 

2. From the Views box, select the view you want to display. 

3. Choose the Show button. 

The view is displayed. 

4. Choose the Close button. 

Jll> To delete a view 

1. From the EIS menu, choose View. 

2. From the Views box, select the view you want to delete. 

3. Choose the Delete button. 

4. Choose the OK button to confirm the deletion of the view. 

The EIS Builder's definition of the document as a view is deleted. The worksheet containing 
the view is unaffected. 

5. Choose the Close button. 

ging Bulletproof Settings 
You can use bulletproof settings to control the user's keyboard and display options, either for 
a specific view or for all new views you create. 

If you change the default settings for all new views, the changed settings do not affect views 
you created previously. 

Jll> To change bulletproof settings for one view 

1. From the EIS menu, choose View. 

2. Select the view for which you want to change the settings. 
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3. Choose the Edit button. 

4. Under Bulletproof, make sure the Active check box is selected. This activates the current 
bulletproofing settings. 

-or-

Under Bulletproof, choose the Settings button. Select the options you want in the 
Bulletproof Settings dialog box, and then choose the OK button. 

5. Choose the OK button to close the View Settings dialog box . 

..,.. To change default bulletproof settings for all new views 

1. From the EIS menu, choose Settings. 

2. Choose the Defaults button. 

3. Under Bulletproof, make sure the Active check box is selected. This activates the current 
bulletproofing settings. 

- or-

Under Bulletproof, choose the Settings button. Select the options you want in the 
Bulletproof Settings dialog box, and then choose the OK button. 

4. Choose the OK button to close the New View Settings dialog box. 

5. Choose the OK button to close the Application Settings dialog box. 

Working with Buttons and Graphics 
You can add buttons to the views in your EIS to allow the user to move easily between views 
and return to the home view, or to carry out other actions or commands. 

Graphic objects offer a way to add visual appeal, point out important data, and show 
information in interesting ways. You can create a graphic object, such as a line, arc, oval, or 
rectangle, using the drawing tools available in Microsoft Excel. You can also create a bitmap 
image in an another drawing or painting application, then paste the image into the view . 

..,.. To add a button to a view 

To move between different views, or to execute actions or commands that are specific to a view, 
you can add buttons to the view. 

1. From the EIS menu, choose Button. 

2. In the Button Type box, select the type of button you want to use. 

3. In the Text box, type the text you want to appear inside the button. 

If the button type you choose cannot display text, the Text box is unavailable. 

4 . To size the button to the active cell, select the Size To Cell check box. 

5. Choose the Draw button. 

The button is drawn starting at the upper-left comer of the active cell, and the Script dialog 
box is displayed. 

6. In the Script dialog box, create the script you want to run when the button is clicked. 

For a description of the options, choose the Help button in the dialog box. 

For more information about creating scripts, see "Working with Scripts" later in this chapter. 

7. When you are done creating the script, choose the Close button. 
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Jll> To edit, move, or resize a button 

1. In Microsoft Excel for Windows, hold down CTRL and click the button. 

In Microsoft Excel for the Macintosh, hold down COMMAND and click the button. 

Handles appear around the selected button. 

2. To edit the script attached to the button, choose the Button command from the EIS menu. 

The Script dialog box is displayed and you can edit the script. 

3. To move the button, click the button while it is selected and move it to the new location. 

4. To resize a button, select the button, click one of the handles, and drag until it is the size you 
want. 

5. When you finish making changes to a button, click elsewhere in the worksheet or press ESC. 

Jll> To edit button text 

1. In Microsoft Excel for Windows, hold down CTRL and click the button. 

In Microsoft Excel for the Macintosh, hold down COMMAND and click the button. 

Handles appear around the selected button. 

The mouse pointer changes to an insertion point. 

2. Click to place the insertion point in the text. 

3. Make the changes you want. 

4. When you finish, click elsewhere in the sheet or press ESC. 

Jll> To add a graphic object to a view 

1. Create the graphic object using the Microsoft Excel drawing tools or create the object in 
another application. 

2. If necessary, paste the object where you want it in the view. 

From another application, copy the object to the Clipboard. Then choose Paste Special 
from the Edit menu, select Bitmap under Data Type, and choose the Paste button. 

3. Select the object by clicking it. 

Handles appear around the selected object. 

4. From the EIS menu, choose Button. 

5. In the Script dialog box, create the script you want to run when the user clicks the object. 

For a description of the options, choose the Help button in the Script dialog box. 

6. Choose the Close button to close the Script dialog box. 

Jll> To delete a button or graphic object 

1. In Microsoft Excel for Windows, hold down CTRL and click the button or graphic object. 

In Microsoft Excel for the Macintosh, hold down COMMAND and click the button or 
graphic object. 

Handles appear around the selected object. 

2. From the Edit menu, choose Clear. 
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.,.. To validate entries in cells 

You can specify cells on your worksheets that prompt the user for a particular type of entry 
when clicked. 

1. Select the cell you want to specify. 

2. From the EIS menu, choose Prompt Cell. 

3. In the Prompt Cell Name dialog box, type a name for the cell. 

If the selected cell already has a name defined, this dialog box is not displayed. 

4. Choose the OK button. 

5. In the Prompt Cell Settings dialog box, select the options you want to use. 

For a description of the options, choose the Help button in the dialog box. 

6. Choose the OK button . 

.,.. To change cell validation settings 

1. Select the cell for which you want to change the setting. 

If the cell is hot, use the arrow keys to select it. 

2. From the EIS menu, choose Prompt Cell. 

3. In the Prompt Cell Settings dialog box, make the changes you want. 

For a description of the options, choose the Help button in the dialog box. 

4. Choose the OK button . 

.,.. To clear cell validation settings 

1. Select the cell for which you want to clear the settings. 

If the cell is hot, use the arrow keys to select it. 

2. From the EIS menu, choose Prompt Cell. 

3. In the Cell Definition dialog box, choose the Delete button. 

Choose the OK button to confirm the deletion of the prompt cell. 

The definition of the cell as a prompt cell is deleted . 

.,.. To unhide all objects 

In the process of developing your EIS, you may show and hide various objects. Use the 
following procedure to quickly display all objects on a worksheet. 

1. From the EIS menu, choose Utilities. 

2. In the Run Utility dialog box, select Unhide All Objects. 

All of the objects on the active document are unbidden. 
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Working with Menus 
You can create custom menus with the EIS Builder. Use custom menus to offer users of your 
EIS easy access to commands that run scripts you have created. Custom menus can either be 
per-view menus, which are displayed only when you display a specific view, or they can be 
application menus, which are displayed at all times when you run an EIS. 

When you define menus, you specify whether they are displayed along with the default 
Microsoft Excel menu bars or displayed on a new manu bar that replaces the Microsoft Excel 
menu bars . 

..,.. To create a new menu 

1. From the EIS menu, choose Menu. 

2. To display the menu on an application menu bar, select the Application option button. 

To display the menu with a specific view, select the Per-View option box on either the 
application menu bar or the Microsoft Excel menu bar. 

3. Under Menu, choose the New button. 

4. In the New Menu dialog box, type the name for the new menu. 

Type & preceding the letter you want to use as the access key. 

5. Choose the OK button. 

The menu name you typed is added to the menu list and the buttons in the Commands section 
of the dialog box are activated, allowing you to create commands to be displayed on the 
menu. 

6. To create another menu, repeat steps 3 through 5. 

7. When you are finished creating new menus, choose the Close button to close the Menus 
dialog box . 

..,.. To display a menu with a particular view 

After creating a custom menu, you can choose to have the menu displayed either when the EIS is 
opened, or when specific views are displayed. 

To do this procedure, you must have already created a menu. 

1. From the EIS menu, choose View. 

2. From the Views box, select the view you want to edit. 

3. Choose the Edit button. 

4. Under Menu Bar, choose the Application option button to specify that the menu should be 
part of a menu bar displayed for the EIS. 

Under Menu Bar, choose the Microsoft Excel option button to display the menu along with 
the default Microsoft Excel menu bars. 

5. Choose the OK button to close the View Settings dialog box . 

..,.. To create a menu command 

To create new commands, you must have created a menu. 

1. From the EIS menu, choose Menu. 

2. Under Commands, choose the New button. 

The Menu Command Definition dialog box is displayed. 
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3. In the Command Text box, type the name you want to use for the command. Type & 
preceding the letter you want to use as the access key. 

4. In the Status Bar Text box, type the text you want displayed in the status bar when the 
command is highlighted. 

For Microsoft Excel for the Macintosh, in the Shortcut Key box, type & followed by the 
letter you want to use as the shortcut key. 

The shortcut key you choose should not conflict with other shortcut keys that will be 
available to the user. 

5. Choose the Script button to create the script to be run when the command is chosen. 

When you are finished creating the script, choose the Close button to close the Script dialog 
box. 

For more information about creating scripts, see "Working with Scripts" later in this chapter. 

6. In the Menu Command Definition dialog box, choose the OK button. 

The new command is added to the list. 

7. To create another command, repeat steps 2 through 7. 

To create a line between commands on the menu, follow steps 2, 3, and 7 above. Instead of 
typing a name in step 3, type a hyphen (-). 

8. When you are finished creating commands, choose the Close button. 

~ To change the order of menus or commands 

1. From the EIS menu, choose Menu. 

2. Select the menu or command you want to move. 

Moving a menu up moves it to the left on the menu bar; moving it down moves it to the right. 

3. To move the menu or command up in the list, choose the Up button. 

To move the menu or command down in the list, choose the Down button. 

4. To save your changes, choose the Close button. 

~ To delete a menu or a command 

1. From the EIS menu, choose Menu. 

2. In the Menus dialog box, select the menu or command you want to delete. 

3. Choose the Delete button. 

The menu or command is deleted. When you delete a menu, all of the commands on that 
menu are also deleted. 

4. Choose the Close button to close the Menus dialog box. 

Working with Scripts 
The Microsoft Excel EIS Builder includes actions that you use to create scripts that change and 
control the display and content of documents included in your EIS. 

Actions are macros that perform many of the basic operations that are essential to creating an 
EIS. You can also create custom actions with Microsoft Excel macros. Scripts are collections of 
actions that you use to have your EIS carry out commands. 
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You use the Settings, View, Button, or Menu commands on the EIS menu to create scripts. 
Scripts can be attached to buttons, views, and menu commands, as well as to the EIS itself. Each 
of these menu commands allows you to create scripts, or to specify an existing named script, and 
assign it to an object in an EIS. When the object is selected, displayed or hidden, clicked or 
updated, the specified script is run. 

You can modify actions by specifying properties unique to some of the actions, such as 
document names, view names, even specific ways that the user can work with a data crosstab 
table. For example, the Open File action can be edited to include the name of the file you want 
to open. You can set conditions to determine whether or not an action should be carried out 
when its script is run. Specifying conditions for individual actions within a script gives you step­
by-step flexibility to determine, while your scripts are running, whether it is appropriate for each 
action to be executed. For example, you might have a script that runs when the user opens a 
worksheet containing a database crosstab table, or a script that contains an action that is carried 
out only if the source database is also open. 

To use a script in more than one object in an EIS, you can assign a name to the script and use it 
in another object with the Run Named Script action. 

To see a list of the actions in the Microsoft Excel EIS Builder, see "Actions" in Chapter 4. 

Since you can add scripts to a variety of objects in an EIS, there are different ways to display the 
Script dialog box, as shown in the following table. 

To add scripts to 

Settings 

Views 

Buttons 

Menus 

.,. To create a script 

From the EIS menu, do this 

Choose the Settings command, and then choose the Scripts button. 

Choose the View command, choose the Add or Edit button, and then choose the 
Scripts button. 

Choose the Button command, then choose the Draw button. You can also select 
a button on a view and choose the Button command. 

Choose the Menu command, create a menu and a menu command, and then 
choose the Scripts button . 

To create a script, the Script dialog box must be displayed. 

1. Under Action Class, select the action class you want. 

A list of the available actions for the actions class is displayed. 

2. In the Available Actions box, select the action you want to add to a script. 

3. Choose the Add button. 

The action is added to the Script box on the right side of the dialog box. For many actions, a 
dialog box is displayed after you choose the Add button. This dialog box allows you to 
specify additional information about the action, such as the description, which you can edit, 
and a condition, which controls when the action is executed. 

4. Repeat steps 1 through 3 until you have created the script you want. 

5. To close the Script dialog box and save the script you created, choose the Close button . 

.,. To set or change a condition for an action 

To set a condition for an action, the Script dialog box must be displayed. 

1. In the Script dialog box, select the action for which you want to set a condition. 

2. Choose the Edit button. 
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3. In the Condition box, type the condition you want to use for the action. 

The condition should be a valid Microsoft Excel formula that returns either TRUE or 
FALSE. 

4. Choose the OK button. 

5. When you are done specifying conditions for actions, choose the Close button in the Script 
dialog box . 

..,. To name a script 

To make a script available to other views, commands, and buttons, you can assign a name to a 
script. After naming a script, you can use the Run Named Script action to run the script 
associated with the name you chose as an action in another script. 

To name a script, the Script dialog box must be displayed. 

1. In the Script dialog box, choose the Name button. 

2. In the Name Script dialog box, type the name you want to use for the script. 

3. Choose the OK button . 

..,. To change a script 

To change a script, the Script dialog box must be displayed. 

l. In the Script box, select the action you want to edit. 

2. Choose the Edit button. 

3. In the Script Action dialog box, make the changes you want. 

4. Choose the OK button. 

5. When you are done editing the script, choose the Close button . 

..,. To change the order of actions in a script 

To change the order of actions in a script, the Script dialog box must be displayed. 

l. In the Script box, select the action you want to move. 

2. To move the action up in the script, choose the Up button. 

3. To move the action down in the script, choose the Down button. 

4. When you are done changing the action order, choose the Close button . 

..,. To delete an action from a script 

To delete an action from a script, the Script dialog box must be displayed. 

1. In the Script box, select the action you want to delete. 

2. Choose the Delete button. 

Choose the OK button to confirm the deletion. 

The selected action is deleted. 

3. When you are done deleting actions, choose the Close button. 

To delete an entire script, select each action in the script and choose the Delete button. When 
you have deleted all of the actions in a script, the name that was assigned to the script is also 
deleted. 
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..,.. To specify a script to be run on startup or exit 

You can create scripts that run automatically when the EIS is opened or closed. Use these scripts 
to execute actions that establish EIS settings when it is opened, or to restore Microsoft Excel 
settings when it is closed. 

1. From the EIS menu, choose Settings. 

2. Choose the Scripts button. 

3. In the Run Script On box, select the option you want. 

4. Create a script that you want to run automatically every time the EIS is opened or closed. 

5. When you are done creating the script, choose the Close button. 

6. Choose the OK button to close the Application Settings dialog box . 

..,.. To present a list of scripts to the user 

You can present a list of named scripts to the user when you specify a list of named scripts on 
a worksheet that you will include with your completed EIS. 

To present a list of scripts to the user, you must have defined at least one named script. For 
more information about naming scripts, see "Working with Scripts," earlier in this chapter. 

1. From the EIS menu, choose Utilities. 

2. Select List Named Scripts. 

3. Choose the OK button. 

A new worksheet is created with the descriptions and script numbers of all the named 
scripts in the active EIS. 

4. Select the range of cells containing the descriptions and script numbers. 

5. From the Formula menu, choose Define Name. 

6. Type the name you want to use for the range of named scripts in the Name box. 

7. Choose the OK button. 

8. Save the worksheet. 

You can now use the name you defined for the range in the Pick List of Scripts action. 
You should be sure to include the worksheet that contains the list with your completed 
EIS . 

..,.. To edit a named script 

To edit a named script, the Script dialog box must be displayed. 

1. In the Script dialog box, select the named script you want to edit. 

2. Choose the Edit button. 

The Script dialog box changes to display the individual actions in the named script you 
selected. 

3. Follow the preceding procedures to change, reorder, or delete actions from scripts. 

4. When you are finished editing the script, choose the Close button. 

The Script dialog box updates to display the named script action. 

5. Choose the Close button. 

The changed script is saved as the named script. 
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~ To add Microsoft Excel macros to your EIS application 

Use the Run External Macros action to incorporate Microsoft Excel macros in your EIS. The 
macro sheet that contains the macros you want to add should be open before you use this action. 
The Microsoft Excel macro is not added to your EIS macro sheet. Instead, a call to the macro 
sheet containing the macro you specify is added to the EIS macro sheet. You should be sure to 
include the macro sheet in the final group of documents you distribute in the completed EIS. 

To do this procedure, the Script dialog box must be displayed and the macro sheet containing the 
macros you want to add to your EIS must be open. 

1. Under Action Class, select the Scripts option button. 

2. In the Available Actions box, select Run External Macro. 

3. Choose the Add button. 

A dialog box is displayed asking you to specify the macro you want to run. 

4. In the Macro Sheet box, select the macro sheet that contains the macro you want to run. 

5. In the Macro box, select the macro you want to run. 

Note If the macro sheet you selected contains more than 256 command macros, only the first 
256 command macros are listed, alphabetically. To use a macro that does not appear in the list, 
type the name of the macro in the Macro box. 

6. Choose the OK button. 

7. In the Script dialog box, choose the Close button. 

Working with Queries and Crosstab Tables 
When you choose to include a query or a cross tab table as part of your EIS, you can also specify 
the way the user will interact with the data, including specifying such options as how often the 
data is updated, whether or not the user can manipulate the data, and whether or not the user's 
changes should be saved in the source database. 

~ To create or modify a database query 

To use a query in an EIS, you must first have created a query on a worksheet. The EIS Builder 
allows you to specify how the user can interact with the query. For example, you can put a 
button on the EIS document that allows the user to perform an existing query stored on the 
worksheet. 

1. From the EIS menu, choose Query. 

2. Enter the information and select the options you want. 

For a description of the options, choose the Help button in the dialog box. 

3. Choose the OK button. 

~ To create crosstab table settings 

You can specify how the user can display, control, and manipulate the contents of a database 
crosstab table. You can allow the user to specify the row, column, and summary fields when the 
crosstab table is initially created or to modify the crosstab table settings later by double-clicking 
in the crosstab table. 
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To do this procedure, the active document must contain a crosstab table report. 

1. Switch to the worksheet for which you want to change the crosstab table settings. 

2. F.r m the EIS menu, choose Crosstabs. 

3. Select the options you want. 

For a description of the options, choose the Help button in the dialog box. 

4. Choose the OK button. 
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CHAPTER 4 

Microsoft Excel EIS Builder 
Reference 

Commands 

Actions 

The following list contains all of the commands that are part of the Microsoft Excel EIS Builder. 
For more information about individual commands, see Help. 

Command 

About 

Button 

Close 

Cross tab 

Exit 

Menu 

New 

Open 

Prompt Cell 

Query 

Run 

Save 

Settings 

Utilities 

View 

Description 

Displays information about the EIS Builder. 

Creates a button and specifies a script to be run when it is clicked. 

Closes the EIS macro file and all associated Microsoft Excel documents. 

Defines how the user will interact with crosstab tables. 

Exits the EIS Builder. 

Creates custom menus and commands, and assigns scripts to commands. 

Creates a new EIS. 

Opens a previously created EIS. 

Controls cell entries. 

Defines how the user will interact with external database queries. 

Runs the EIS you are creating from the user view, temporarily disabling 
development capabilities. 

Saves changes made to all of the active EIS documents, including any add-in macro 
files created by the EIS Builder. 

Sets the global constants for the EIS you are creating. 

Displays all hidden objects on the active document. 

Creates, displays, edits or deletes a view. 

The following list contains all of the actions that are part of the Microsoft Excel EIS Builder, as 
displayed in the Script dialog box. For more info~ about using actions, see "Working with 
Scripts" in Chapter 3. For more information about individual actions, see Help. 

View Actions 

Display View 

Next View 

Previous View 

Home View 

Clear Previous Path 

Description 

Displays the specified view. 

Displays the next view. 

Displays the previous view. 

Displays the home view. 

Clears the list of previous views the user displayed. 
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File/Window Actions 

Open File 

Close File 

Save File 

Activate Window 

Unhide Window 

Hide Window 

Print 

Print Microsoft Excel Report 

Data Access Actions 

Define a Crosstab 

Calculate a Crosstab 

Drilldown a Crosstab Cell 

Create Chart from Crosstab 

Recreate Chart from Crosstab 

Logon 

Logoff 

Perform Query 

Display Actions 

Expand Outline 

Collapse Outline 

Outline Level 

Hide Object 

Unhide Object 

Toggle Object 

Show Outline Symbols 

Hide Outline Symbols 

Toggle Outline Symbols 

Beep 

Echo On 

Echo Off 

Show Microsoft Excel View 

Show Microsoft Excel Scenario 

Description 

Opens the specified document. 

Closes the specified document. 

Saves the specified document. 

Activates the specified window. 

Unhides the specified window. 

Hides the specified window. 

Prints the current view. 

Prints a specified Microsoft Excel report. 

Description 

Defines or modifies a crosstab table on the active 
worksheet. 

Calculates the current crosstab table. Takes no action if 
the currently active worksheet does not contain a 
crosstab table. 

Performs a crosstab table drilldown on a specified cell. 

Creates a chart from a crosstab table. 

Adjusts a chart definition to fit the current crosstab table. 
Makes appropriate adjustments to the crosstab table 
definition based on the number of x and y fields in the 
cross tab table and the number of fields being 
summarized. 

Connects to an external database. Displays the Q+E 
dialog box and prompts the user for a password, if one is 
required. 

Disconnects from an external database. 

Carries out a query. 

Description 

Expands an outline. 

Collapses an outline. 

Displays the specified outline level. 

Hides the specified object. 

Displays the specified hidden object. 

Displays or hides the specified object. 

Displays outline symbols. 

Hides outline symbols. 

Displays or hides outline symbols . 

Sounds a tone. 

Turns on macro echo. 

Turns off macro echo. 

Displays the specified Microsoft Excel view. 

Calculates a worksheet model based on a specified 
Microsoft Excel scenario. 



Cell Actions 

Calculate Document 

Set Cell Value 

Enter Prompt Cell 

Clear Range 

Copy- Paste 

Calculate All 

Apply Style 

Select Range 

Script Actions 

Run Named Script 

Pick List of Scripts 

Run External Macro 

IF-ELSE-END.IF 

Time Delay 

Timed Execution 

Application Actions 

Quit Microsoft Excel 

Quit EIS 

Show Application Menu Bar 

Show Microsoft Excel Menu Bar 

Enable Command 

Disable Command 

Alert Box 

Activate Bulletproofing 

Deactivate B ulletproofing 

Help 

Inter-Application Actions 

Initiate DDE Channel 

Perform DDE Operation 

Poke DDE Data 

Request DDE Data 
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Description 

Calculates the active document. 

Enters a value into a cell. 

Displays the Prompt Cell dialog box. 

Clears the specified range. 

Copies a range to another range. 

Calculates all open documents. 

Applies a predefined style or styles to a cell range based 
on criteria you specify. 

Selects the specified range. 

Description 

Runs a named script of actions. 

Presents the user with a selected list of scripts to run. 

Runs a macro as a custom action. 

Inserts an IF, ELSE, END .IF structure into a script. 

Specifies a time delay before running the next action in a 
script. 

Specifies a time to run the next action in a script. 

Description 

Quits the active EIS and Microsoft Excel. 

Quits the active EIS. 

Displays the menu bar and menus you created using the 
Menu command on the EIS menu. 

Displays the default Microsoft Excel menu bar for the 
active sheet. 

Enables a menu command previously disabled by the 
Disable Command action. 

Disables a menu command you create using the Menu 
command on the EIS menu. 

Displays an alert box. 

Turns on bulletproofing settings for the active view. 

Clears bulletproofing settings for the active view. 

Displays a specified custom help topic. 

Description 

Opens a dynamic data exchange (DDE) channel to 
another application. 

Performs a specified dynamic data exchange (DDE) 
operation. 

Sends Microsoft Excel data to another Microsoft 
Windows application using a dynamic data exchange 
(DDE) channel. 

Requests data from a topic in another Microsoft 
Windows application using a dynamic data exchange 
(DDE) channel. 
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Inter-Application Actions 

Close DDE Channel 

Activate Application 

Reference to EIS Macro Sheets 

Description 

Closes the currently active dynamic data exchange 
(DDE) channel to another application. 

Switches to the application to which you have opened a 
dynamic data exchange (DDE) channel. 

The following macro sheets are contained in the disks for the EIS Builder. An asterisk(*) 
denotes run-time files required by users of your EIS only. 

File Name 

APP.XLA 

AUTHOR.XLA 

BUTTONS.XLA 

CELLDEF.XLA 

*EIS.XLA 

MENU.XLA 

XTAB.XLA 

*XTACTION.XLA 

Description 

Records on a macro sheet the choices you make when 
creating an EIS. 

Contains the main macros used to create an EIS in 
Microsoft Excel. 

Contains the macros used to create buttons and the 
bitmaps for the buttons. 

Contains the macros used to create prompt cells . 

Contains the macros used to create a run-time EIS. 

Contains the macros used to create custom menus and 
commands. 

Contains the macros used to control access to crosstab 
tables with the EIS. 

Contains the macros used to execute crosstab table actions 
in a run-time EIS. 

Note These run-time files should reside in the same directory or folder as the application, or in 
the Microsoft Excel Library directory or folder. 
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Action 
Actions represent macros that run the most common commands in a Microsoft Excel-based EIS. 
You use actions to create scripts. There are nine categories of actions in the Microsoft Excel 
EIS Builder: Display, Scripts, Application, InterApplication, Cells, Edit, Data Access, 
Files/Windows, and Views. 

Application menu 
An application menu is a custom menu bar that is displayed any time that your EIS is active. The 
application menu replaces the Microsoft Excel menu bar. 

Bulletproofing 
Bulletproofing is a set of constraints you can put on your entire EIS or on specific views that 
restricts the ability of the user to perform specific actions such as displaying workspace options 
and using various command keys. 

Controls 
A control is an object to which you attach a script. A control can be a custom menu, a menu 
command, a button, a validated cell or a prompt cell. 

Home view 
The home view introduces the EIS and is the point of return from other views that the user 
encounters when using the EIS. The home view should contain controls that allow the user to 
display other views and to quit the EIS. 

Named script 
A named script is a script to which you have applied a name. The name allows you to group the 
actions contained in the script as one action in another script. 

Per-view menu 
A per-view menu is a custom menu that is displayed only when a specific view is activated. 

Script 
A script is a list of actions that are run when an EIS is opened or closed, when a button is 
clicked, when a custom command is chosen, or when a view is opened, closed, entered, exited, 
or changed. 

View 
A view is a range on a worksheet that you want to display. The EIS Builder saves the selected 
range and the display and workspace options associated with that range. The area defined as the 
view should contain information that you want the EIS user to see, such as data tables and 
charts, as well as controls that allow the user to manipulate data or move between views. 
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A 
Aboutconunand 31 
Actions 

See also individual actions 
defined 35 
working with 25-27 

Activate Application action 34 
Activate Bulletproofing action 33 
Activate Window action 32 
Add-in macro sheet, opening 32 
Adding buttons 21 
Adding EIS menu 15 
Alert Box action 33 
APP.XLA, recording commands on 17 
APP.XLA macro sheet 17, 34 
Apple Macintosh, knowledge required v 
Application Actions 33 

See also individual actions 
Application menu 33 
Application Menus option button, displaying menus with 33 
Application option button, specifying views with 8 
Apply Style action 33 
Author mode 

returning to with Halt tool 17 
running scripts in 9 
switching from user mode 17 

AUTHOR.XLA 
adding EIS menu with 15 
using to create new EIS 7 

AUTHOR.XLA macro sheet 34 
Authoring conunands, disabling with Run command 17 
Automatic format, applying to cross tab tables II 

8 
Beep action 32 
Bitmap, creating 21 
Bulletproof options, specifying 20-21, 32 
Bulletproof settings 20-21 
Bulletproofing, defined 5, 35 
Buttons 

about 21 
adding 8, 21 

to change between views 12 
attaching scripts to 4, 12, 26 
creating and editing 21-23 

Buttons (continued) 
deleting 22 
using in an EIS 4 

Button command 31 
EIS menu 21 
using scripts with 4 

BUTTONS.XLA macro sheet 34 

c 
Calculate a Crosstab action 32 
Calculate All action 33 
Calculate Document action 33 
Cell 

validating entries 23 
with user prompt, creating 9 

Cell Actions 33 
See also individual actions 

Cell data, specifying 5, 23 
Cell validation, changing 23 
CELLDEF.XLA macro sheet 34 
Change Crosstab button 12 
Changing 

an existing EIS 12 
bulletproof settings 20-21 
scripts 27 

Chart, displaying and toggling 8-9 
Clear Previous Path action 31 
Clear Range action 33 
Clear Retrace Path action 31 
Close command 31 
Close DOE Channel action 34 
Close File action 32 
Closing an EIS 18 
Collapse Outline action 32 
Commands 31 

See also individual commands 
adding to menu 12-13 
changing order of 25 
creating 24-25 
creating lines between on menu 25 
deleting 25 
to create scripts 26 

Index 37 

Conunand macros, maximum number listed 29 
CompuServe forums and memberships vii 
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Condition, specifying 26-27 
Control, defined 35 
Copy - Paste action 33 
Create Chart from Crosstab action 32 
Creating 

an EIS 3, 16 
buttons 21 
commands 24-25 
crosstab table settings 29-30 
custom menus 24 
database queries 29 
documents 3 
menu commands 24-25 
prompt cells 9, 23 
scripts 26 
views 19 
worksheets 3 

Crosstab command 31 
EIS menu II 

Crosstab settings 
creating 29-30 
defining 11 

Crosstab source data sheet 10 
closing when exiting 10 
opening when entering 10 

Crosstab tables 
allowing user specifications to 11 
settings, creating 29-30 
using to define user interaction 5 
working with 9-11 , 29-30 

Custom command, creating and displaying 12-13 
Custom menu 

creating 12, 24 
displaying with particular views 24 

Custom scripts, creating 26 

D 
Data Access Actions 32 

See also individual actions 
Data exchange, controlling See Inter-Application actions 
Data validation, in specified cells 5 
Database query, creating or modifying 29 
Deactivate Bulletproofing action 33 
Default view settings, specifying 17 
Define a Crosstab action 32 
Defining 

cross tab table settings 11 , 29 
database queries 11 , 29 
menus and scripts 24 
views 18-20 

Deleting 
actions from scripts 27 
buttons 22 

Deleting (continued) 
graphic objects 22 
menus and commands 25 
views 20 

Disable Command action 33 
Display Actions 32 

See also individual actions 
Display option button 32 
Display View action 31 
Displaying 

charts 8-9 
document links list 18 
menus 8 
Microsoft Excel menu bar 33 
script dialog box 26 
views 12,20 

Document, creating before EIS use 16 
Document links, displaying list of 18 
Drilldown a Crosstab Cell action 32 

E 
Echo Off action 32 
Echo On action 32 
Editing 

buttons 22 
scripts 27 

EIS (Enterprise Information System) 
adding Microsoft Excel macros to 29 
closing 18 
components of 2-3 
creating new 16 
exiting 18 
installing 15 
menu, displaying with Microsoft Excel menus 24 
opening 16 
running 14 
saving 17 
testing 5 
tour 7 

EIS Builder 
about 1 
defined I , 15 
dialog box, getting help on vi 
functionality 1-2 
installing 5, 15 
macros 1 
parts of 1-3 
presentation and control 
setup and installation support viii 

EIS Builder Help 
contents vi 
specific topics vi 
viewing in Microsoft Excel vi 



EIS Builder messages, getting Help on vi 
EIS commands, getting Help on vi 
EIS data, effective presentation of v 
EIS document, creating 3 
EIS macro sheet 34 

about 3 
commands recorded in 16 
recording actions on 3 

EIS menu 
adding to Microsoft Excel menu bar 24 
using 3 

EIS MENU macro sheet 34 
EIS settings, specifying 16 
EIS.XLA macro sheet 34 
Enable Command action 33 
Enter PromptCell action 33 
Enterprise Information System See EIS 
Excel macros See Microsoft Excel, macros 
Exit, running scripts upon 28 
Exit command 31 
Exiting 

an EIS 14 
EIS Builder 18 
Microsoft Excel 33 

Expand Outline action 32 

F 
File/Window Actions 32 

See also individual actions 
First view, defining 13 

G 
Global settings, specifying 16 
Graphic object 

adding to views 22 
deleting 22 

Graphics, use of 21 

H 
Halt tool, returning to author mode with 17 
Hearing impaired, product support for viii 
Help 

See also Product support 
contents vi 
dialog or messages boxes vi 
EIS Builder, viewing in Microsoft Excel vi 
EIS commands vi 
Microsoft Excel, available in EIS Builder vi 
online, accessing vi 
searching for specific topics vi 

Help action 33 
Hide Object action 32 
Hide Outline Symbols action 32 
Hide Window action 32 
Hiding toolbars 7 
Home view 35 

defining 13 
parts of 18 

Home View action 31 
Hot cell 

See also Prompt Cell 
creating 9 
restricting entries in 9 

IF-ELSE-END.IF action 33 
Initial views, specifying 13 
Initiate DDE Channel action 33 
Installation requirements 33 
Installing 

an EIS 5-7 
EIS Builder 15 

Inter-Application Actions 34 
See also individual actions 

L 
Logoff action 32 
Logon action 32 

M 
Macintosh, knowledge required v 
Macro language, Microsoft Excel v 
Macro sheet 

commands recorded in 15 
including with other EIS parts 7 
new 7 
recording EIS commands on 7 

Macros, use of 29 
Microsoft Excel, adding to EIS 29 

Menu 24-26 
adding commands to 12-13, 24-25 
application, defined 32 
displaying with views 8 
EIS, adding 8 
per-view, defined 24 
specifying 8 

Menu bar, Microsoft Excel 24 
Menu command 31 

displaying chart view with 24 
using to create scripts 25 

Index 39 
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MENU.XLA macro sheet 34 
Message box, getting Help in vi 
Microsoft Excel 

documents, working with 16 
exiting 33 
knowledge required v 
macro language, enhancing EIS with v 
macros, adding to EIS 29 
menu bar, displaying 33 
menus, displaying EIS menus with 24 

Microsoft Excel EIS See EIS 
Microsoft Excel Help, available in EIS Builder vi 
Microsoft License Agreement vii 
Microsoft Sales, hours of operation viii 
Microsoft Support Services See Product support 
Microsoft Windows, knowledge required v 
Microsoft Windows Paintbrush, creating bitmaps with 21 
Modifying 

actions 26 
an existing EIS 26 
database queries 29 

Moving buttons 22 
Multiple objects, using in scripts 26 

N 
Naming scripts 27 
Navigation between views, controlling 4 
New command 31 
New EIS, creating 16 
Next View action 31 

0 
Objects, unhiding 23 
Online Help, using vi 

See also Help 
Open command 31 
Open File action 32 
Opening an EIS 16 
Order 

menus and commands, changing 24 
script actions, changing 27 

Outline Level action 32 

p 
Password, specifying 16-17 
Pasting graphic objects from Clipboard 22 
Per-view menu, defined 24, 35 
Perform DDE Operation action 33 
Perform Query action 32 
Pick List of Scripts action 33 

Poke DDE Data action 33 
Previous View action 31 
Print action 32 
Product support vii 

for hearing impaired vu1 
hours of operation viii 
on CompuServe forums vii 
outside United States vii-viii 
within United States vii 

Prompt cell 
See also Cell validation 
changing settings 23 
creating 9, 23 

Prompt Cell command 31 

a 
Query 

using to define user interaction 5 
working with 29-30 

Query command 31 
Quit EIS action 33 
Quit Microsoft Excel action 33 

R 
Range, specifying as view 8 
README.TXT 5 
Recreate Chart from Crosstab action 32 
Redefining crosstabs, allowing user to 11, 29 
Remote data source, linking worksheets to 2 
Removing action from script 27 
Request DDE Data action 33 
Restricting cell data entry 5, 9, 23 
Run command 31 

disabling authoring commands with 17 
Run External Macro action 33 
Run Named Script action 33 
Run-time file vii 
Running 

an EIS 16 
scripts, on startup or exit 28 

Running script 
author mode 9 
Toggle Chart button 9 

s 
Save File action 32 
Save command 31 
Saving an EIS 17 



Script 
attaching to EIS elements 26-27 
creating 25-27 
defined 4, 25, 35 
deleting 27 
editing 27 
editing named 28 
list, presenting to user 28 
naming 27 
running on startup or exit 28 

Script Actions 33 
See also individual actions 

Script actions, changing order of 27 
Script dialog box, displaying 26 
Select Range action 33 
Selecting graphic objects 22 
Set Cell Value action 33 
Settings 

adding scripts to 26 
cell validation, clearing 23 

Settings button 
bulletproofing, changing with 21 

Settings command 31 
EIS menu 20 
using to create scripts 26 

Setup and installation support, EIS Builder viii 
Shortcut key 

using & prefix 25 
using with other shortcut keys 25 

Show Application Menu Bar action 33 
Show Microsoft Excel Menu Bar action 33 
Show Microsoft Excel Scenario action 32 
Show Microsoft Excel View action 32 
Show Outline Symbols action 32 
Size to Cell option, buttons 21 
Sizing buttons 21 
Source data sheet 

closing when exiting I 0-11 
opening when entering 10 

Specific topic, searching Help for vi 
Specifying 

bulletproof options 20-21 
cells for data validation 5, 9, 23 
conditions 26 
default view settings 17 
double-clicking 16 
EIS settings 16-17 
initial views 17 
menus 24 
passwords 16 
prompt cells 5, 9, 23 
ranges, as views 8 
script run time 28 
view, with Application option button 8 

Splash file, adding 7-8 
demonstration 7 

Starting EIS Builder 15 
Startup, running scripts on 28 
Support services See Product support 

T 

Index 41 

TDDITT (Text Telephone) product support vm 
Testing a completed EIS 5 
Time Delay action 33 
Timed Execution action 33 
Toggle Chart button 9 
Toggle Object action 32 

Available Actions box 9 
Toggle Outline Symbols action 32 
Toggling charts 8-9 
Toolbar, hiding 7 
Tour 7-14 

u 
Unhide Object action 32 
Unhide Window action 32 
Unhiding objects 23 
Unlisted macros, using 29 
User changes to crosstab tables, allowing 11 
User interaction, controlling 5 
User mode 

Halt tool 17 
running an EIS in 17 

User prompt, creating cells containing 5, 9, 23 
User specifications, to crosstab tables 29 
Utilities command 31 

v 
Validation settings, cells 23 
Views 

about 18 
adding scripts to 26 
changing between, with buttons 12 
changing existing 20 
controlling navigation between 4 
creating 19 
deleting 20 
displaying 20 
parts of 18 

View Actions 31 
See also individual actions 

View command 31 



42 Index 

w 
Windows See Microsoft Windows 
Worksheets 

about 2 
adding buttons to 11 , 21 
using with other applications 2 

Worldwide product support viii 

X 
XTAB.XLA macro sheet 34 
XTACTION.XLA macro sheet 34 
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